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IPM FAQs

This appendix provides answers to the following frequently asked questions about 
IPM:

• What is IPM?

• Do I need to have CiscoWorks for UNIX or CiscoWorks2000 software to use 
IPM?

• When will the IPM server be available on Windows NT and Windows 2000?

• Does IPM require an NMS such as HP OpenView or NetView?

• Does IPM require a dedicated hardware probe to measure and monitor 
network performance statistics?

• Does the IPM application take measurements from the point of view of the 
management workstation?

• What workstation and network devices do I need to run IPM?

• Can I run IPM on my Windows PC?

• I want to run the IPM client as an applet from a Web browser. How can I find 
out if I already have the Java plug-in?

• Why does my IPM client hang when I’m trying to run it as an applet on 
Solaris?

• How do I install the IPM client?

• Do I have to install any software on the router to use SA Agent and IPM?

• Can I configure collectors that use SA Agent targets and NNTP, POP3, or 
SMTP operations?
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• Which Cisco hardware platforms support the SA Agent feature of the Cisco 
IOS software?

• How does IPM interact with the SA Agent feature of the Cisco IOS software?

• What is the name of the MIB used by IPM?

• Does a target device need to be a router that supports SA Agent?

• What network protocols do IPM and SA Agent support?

• Do I have to run a Cisco IOS software release with the SA Agent feature on 
all my routers to get hop-by-hop performance statistics?

• Should I install the router component of IPM on a backbone router so that it 
intercepts all paths?

• Why is IPM no longer part of the CiscoWorks Blue family of products?

• How does IPM measure latency between routers in the SNA environment?

• Cisco recently announced a partnership with Concord. The Concord Network 
Health application generates reports based on the same SA Agent feature 
used by IPM. Should I purchase IPM or Concord Network Health?

• I currently own IPM Release 1.0 for Solaris. Can I upgrade to IPM Release 
2.3?

• I currently own IPM Release 1.0 for AIX or HP-UX. Can I upgrade to IPM 
Release 2.3?

• I upgraded my IPM servers to Release 2.3, and now IPM is not working. 
Why?

• How much of the router’s memory do collectors in SA Agent consume?

• How frequently can network performance measurements be taken?

• When I make changes to IPM components, how can I force IPM to detect the 
changes now, without waiting for the next automatic poll?

• When IPM collects the data from the SA Agent using SNMP, is this data 
averaged or summarized in any way?

• Are there plans to support IPM on Solaris for Intel platforms?

• What data collectors are available in IPM 2.3?

• For TCP Connect operations, what port numbers does IPM support?
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• Why does my TCP Connect collector generate “No Connection” errors when 
I use an SA Agent device as the target, with a target port number greater than 
1024?

• Why won’t IPM accept my timeout values for TCP Connect and DNS 
operations?

• For UDP operations, what port numbers does IPM support?

• Does IPM provide a default HTTP operation?

• Is IPM packaged with CiscoWorks2000?

• How many data collectors can IPM support?

• When IPM configures the routers, it seems that the configuration is a running 
configuration and not saved. What happens when the router is rebooted?

• Where can I find the latest information and software updates for IPM?

• Is the IPM database schema published?

• What if I lose a connection to a server?

• Why does IPM lock up sometimes when I’m running in a Web browser?

• I launched the IPM client from the command line, and now I can’t launch the 
client from a Web browser session. Why?

• Why can’t I access IPM Help on my Solaris workstation?

• Do keyboard shortcuts work when I run IPM in Netscape Navigator?

• In the Target Configuration window, all of my targets show Responder On as 
either No (off) or Not Applicable. How can I turn on the Responder for a 
target?

• Why won’t IPM let me delete one of my targets?

• If I see errors in graphs, what are some problems to look for?

• On the Source Properties window, how is it possible for my system up time 
to be longer than the time since the last reboot?

• When I enter the show rtr configuration command, I see RTR-related 
configuration settings on my source routers. Why?

• Does IPM support data export?

• How do I change the IP address or host name of an IPM server?

• Why do I get an error message when I use a host name as a new IP address?
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What is IPM?
• My client system has multiple IP addresses and I'm having problems staying 
connected to the IPM server from this client. How can I correct this problem?

• What if I accidentally create a collector that uses all remaining memory in the 
source router?

• What is casusers group?

• In IPM 2.3, why do file permissions get changed to casuser::casusers after 
installation?

• In IPM 2.3, why can some commands be run by root only, and others by 
members of the casusers group?

• After remote upgrade, why do collectors encounter synchronization problems 
if both versions of IPM are run simultaneously?

• Can IPM 2.3 co-exist with older versions of IPM on the same network?

What is IPM?
IPM is an application for measuring and monitoring network performance 
statistics such as network latency, jitter, availability, packet loss, and errors. You 
can view these statistics in real time, or have IPM store them in its database for 
historical analysis. You can also use IPM to establish network baselines and 
monitor thresholds.

Do I need to have CiscoWorks for UNIX or 
CiscoWorks2000 software to use IPM?

IPM is functionally a standalone product, with the following considerations:

• If the IPM server and CiscoWorks2000 are installed on the same workstation, 
IPM integrates with the CiscoWorks2000 desktop to provide access to 
summary reports, seed files, and server status information.
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When will the IPM server be available on Windows NT and Windows 2000?
• IPM can use inventory information stored in CiscoWorks2000 Resource 
Manager Essentials to define source routers and target devices to collect 
latency data.

• IPM requires the CiscoWorks2000 Common Management Foundation (CMF) 
Version 2.0 or later.

When will the IPM server be available on Windows 
NT and Windows 2000?

Starting with IPM Release 2.2, the IPM server is available on Windows NT. 
Starting with IPM Release 2.3, the IPM server is also available on Windows 2000.

Does IPM require an NMS such as HP OpenView or 
NetView?

IPM is functionally a standalone application. It has no dependencies on these 
network management platforms.

However, if you want to generate Simple Network Management Protocol (SNMP) 
traps from the source routers used by IPM, you must have a network management 
system (NMS) set up to receive and view the traps. IPM itself does not receive the 
traps.

Does IPM require a dedicated hardware probe to 
measure and monitor network performance 
statistics?

No. IPM utilizes the Service Assurance (SA) Agent software feature embedded in 
the Cisco IOS software of a router or Catalyst Route Switch Module (RSM) to 
measure network performance statistics.
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Does the IPM application take measurements from the point of view of the management workstation?
Does the IPM application take measurements from 
the point of view of the management workstation?

No. IPM configures the SA Agent feature of a router or RSM running Cisco IOS 
software to take measurements. The measurements are taken within the network 
rather than from the management workstation.

What workstation and network devices do I need to 
run IPM?

IPM comprises several distinct pieces of functionality.

• The IPM server application runs on Solaris, Windows NT, and Windows 2000 
Server and Windows 2000 Professional.

• The IPM client application, including the user interface, runs on Solaris, 
Windows 95, Windows 98, Windows NT, Windows 2000 Server, and 
Windows 2000 Professional. For Solaris and Windows NT, the IPM client 
can run on the same system as the IPM server, or on a different system.

• We strongly recommend version 12.1 or later of the Cisco IOS software.

• The IPM application requires a software agent embedded in the Cisco IOS 
software, called the SA Agent to source network performance measurements. 
At least one router running a Cisco IOS software release that supports 
SA Agent is required.

• If you are using IPM to monitor SNA latency, you must install the NSPECHO 
mainframe application on your MVS system. NSPECHO is distributed with 
the IPM software.

• IPM provides access to historical reporting information via a Web browser. 
To view this information, you need a Web browser, such as Netscape 
Navigator or Microsoft Internet Explorer, on your workstation.
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Can I run IPM on my Windows PC?
Can I run IPM on my Windows PC?
You can run the IPM client user interface on Windows 98, Windows NT, 
Windows 2000 Professional or Windows 2000 Server on your PC. However, the 
IPM server must run on a Solaris or Windows NT system, Windows 2000 
Professional, and Windows 2000 Server.

Optionally, you can run the IPM client as an applet from an Internet Explorer or 
Netscape Navigator Web browser if you have installed the Java plug-in 1.3. (For 
information about installing the Java plug-in, see the “Installing IPM on 
Windows” chapter of the Cisco Internetwork Performance Monitor Installation 
Guide.)

I want to run the IPM client as an applet from a Web 
browser. How can I find out if I already have the Java 
plug-in?

From the IPM Main window, select View > Server Home Page. When the Web 
Server Home Page displays, click Launch Secure Web Client (if you are an 
administrator of your network) or Launch Web Client (if you are not an 
administrator).

• If you already have the Java plug-in, the Java applet loads and the Web client 
launches.

• If you do not have the Java plug-in, the IPM Client main window displays a 
window and the prompt Click here to get the plug-in. Click the prompt and 
continue with the plug-in installation procedure, as described in the 
“Installing IPM on Windows” chapter of the Cisco Internetwork Performance 
Monitor Installation Guide.
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Why does my IPM client hang when I’m trying to run it as an applet on Solaris?
Why does my IPM client hang when I’m trying to run 
it as an applet on Solaris?

There may be a problem with the CLASSPATH environment variable.

CLASSPATH specifies the path to the Java class library on your system. However, 
if CLASSPATH is set in the environment from which you launch the Web browser, 
the Java plug-in cannot function properly, and you cannot run the IPM client as 
an applet.

To prevent this problem, use the following procedure to make sure CLASSPATH 
is not set in the environment from which you launch the Web browser:

Step 1 On the command line, enter the env command. A list of environment settings is 
displayed.

Step 2 Find CLASSPATH in the list.

Step 3 If CLASSPATH is not set to null (no characters), set it to null.

For csh or tcsh, enter:setenv CLASSPATH

For ksh, enter:

export CLASSPATH=

CLASSPATH is set to null, and you can run the IPM client as an applet. Also make 
sure that you set the environment variables NPX_PLUGIN_PATH and 
NPX_JRE_PATH to the correct values.

For example in ksh, enter:

export NPX_PLUGIN_PATH=/opt/NSCPcom/j2re1_3_0/plugin/sparc
export NPX_JRE_PATH=/opt/NSCPcom/j2re1_3_0

For more detailed and current information on the environment variables to be set, 
refer the installation instructions of Netscape.

How do I install the IPM client?
You can install the IPM client either from the CD distributed with IPM, or by 
using a Web browser to download the IPM client from an IPM server.
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Do I have to install any software on the router to use SA Agent and IPM?
Do I have to install any software on the router to use 
SA Agent and IPM?

The SA Agent is embedded in many but not all feature sets of the Cisco IOS 
software. A release of the Cisco IOS software which supports SA Agent must be 
installed on the device IPM uses to source network performance measurements. 
The following table summarizes which Cisco IOS software releases support 
SA Agent and indicates the maximum number of collectors

.

Cisco IOS Release1

1. We strongly recommend version 12.1 or later of the Cisco IOS software.

Cisco IOS
Feature Set

SA Agent/IPM 
Support

Maximum Number 
of Collectors

11.2(18) or later IP Plus
Desktop Plus
IBM
Enterprise

Yes 2002

2. The maximum number of collectors supported by any given router might be less than 200 or 500. 
This number is dependent on several factors including the router configuration buffer size, the 
amount of DRAM installed in the router, and the type of collectors configured in IPM.

IP Only
IP/IPX
Desktop

No –

11.3(6) or later IP Plus
Desktop Plus
IBM
Enterprise

Yes 2002

IP Only
IP/IPX
Desktop

No –

12.0(5) and later All Yes 5002

12.0(5)T and later3 All Yes 5002

12.1(1) and later All Yes 5002

12.1(2) T and later All Yes 5002
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Can I configure collectors that use SA Agent targets and NNTP, POP3, or SMTP operations?
Note A collector is the term that IPM uses to describe an entity that performs a 
specific measurement between a specific source router and target device.

Can I configure collectors that use SA Agent targets 
and NNTP, POP3, or SMTP operations?

No. SA Agent targets are routers, and routers cannot perform NNTP, POP3, or 
SMTP services.

If you configure a collector with an SA Agent target and an NNTP, POP3, or 
SMTP TCP Connect operation (such as DefaultNNTP, DefaultPOP3, or 
DefaultSMTP), IPM displays “No Connection” error messages and does not 
collect data.

Which Cisco hardware platforms support the 
SA Agent feature of the Cisco IOS software?

As of the publication of this document, all platforms supporting the Cisco IOS 
software also support the SA Agent with the exception of the following:

• Cisco 1000 series router

• Cisco 800 series router

• Cisco 700 series router

• Cisco 90 series router

As new platforms are released, they might or might not include support for 
SA Agent, based on various factors.

3. IP Path Echo collectors are not supported on routers running Cisco IOS software release12.0(x)T. 
To create IP Path Echo collectors, you must upgrade the routers defined as source routers to Cisco 
IOS software release 12.1(1) or later.
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How does IPM interact with the SA Agent feature of the Cisco IOS software?
How does IPM interact with the SA Agent feature of 
the Cisco IOS software?

IPM uses SNMP to configure the SA Agent in the Cisco IOS software of a source 
router or RSM to take measurements of network performance statistics. IPM then 
uses SNMP to collect the statistics from the SA Agent, and stores that information 
in a database for future presentation and analysis.

What is the name of the MIB used by IPM?
IPM configures and queries the RTTMON MIB, which is supported by the 
SA Agent feature in the Cisco IOS software. You can download this MIB from the 
cisco.com.

Does a target device need to be a router that 
supports SA Agent?

No. IPM supports targets as long as they are reachable through IP. These targets 
can be Web servers, PCs, printers, routers, switches, other network devices, or any 
other device with an IP address. IPM also supports SNA targets running the 
NSPECHO application provided with IPM.

However, if you are measuring UDP, Enhanced UDP, or Jitter statistics for 
applications such as Voice over IP or VPN monitoring, the target must be a Cisco 
router running a release of the Cisco IOS software that supports the SA Agent 
Responder feature (Cisco IOS version 12.1(2)T or later; we strongly recommend 
version 12.1 or later).
A-11
Cisco Internetwork Performance Monitor User Guide

78-11009-02



Appendix A      IPM FAQs
What network protocols do IPM and SA Agent support?
What network protocols do IPM and SA Agent 
support?

IPM and SA Agent support both IP and SNA monitoring. IPM and SA Agent also 
support higher level IP protocols including DHCP, DLSw, DNS, HTTP, TCP, and 
UDP.

Do I have to run a Cisco IOS software release with 
the SA Agent feature on all my routers to get 
hop-by-hop performance statistics?

No. Only routers actually sourcing the network performance measurements, or 
routers defined as targets for Enhanced UDP and Jitter measurements, must run 
the SA Agent feature.

Should I install the router component of IPM on a 
backbone router so that it intercepts all paths?

The answer depends on the number of collectors you are using at any one time. A 
collector is the entity IPM creates on a router to collect performance data. The 
router component of IPM uses memory and CPU cycles, so Cisco recommends 
you run the router component on multiple edge routers instead. This setup 
distributes the load across multiple routers and better simulates typical network 
traffic patterns.
A-12
Cisco Internetwork Performance Monitor User Guide

78-11009-02



Appendix A      IPM FAQs
Why is IPM no longer part of the CiscoWorks Blue family of products?
Why is IPM no longer part of the CiscoWorks Blue 
family of products?

The CiscoWorks Blue line of products is targeted at customers who have a mixed 
SNA and IP environment. IPM is now being delivered as part of the 
CiscoWorks2000 Routed WAN Management bundle to better represent its focus 
on a wider range of IP-based monitoring requirements.

How does IPM measure latency between routers in 
the SNA environment?

In the SNA environment, IPM uses an SNA ping. The IPM application includes a 
component that runs on the mainframe. The router component of IPM sends a 
block of data (the request) to the mainframe component, which in turn responds 
with a block of data (the response). Both the request and response sizes can be 
customized by the user so that traffic flow for various applications can be 
modeled. IPM supports the “SNA ping” over dependent logical unit (LU) 
sessions.

IPM also measures SNA latency from a router to the mainframe over a system 
services control point (SSCP)-LU session. For these types of sessions, the 
mainframe component of IPM is not necessary. In this scenario, IPM uses an SNA 
ECHOTEST to solicit an SNA REQECHO from the mainframe over the SSCP-LU 
session.
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Cisco recently announced a partnership with Concord. The Concord Network Health application generates reports 
Cisco recently announced a partnership with 
Concord. The Concord Network Health application 
generates reports based on the same SA Agent 
feature used by IPM. Should I purchase IPM or 
Concord Network Health?

IPM and Concord Network Health offer different features and benefits:

• IPM is a network performance and troubleshooting tool. The reporting 
features within IPM are designed to troubleshoot network performance 
problems.

• Concord Network Health is designed to report on multiple performance 
statistics on devices from multiple vendors.

• IPM also supports viewing real-time statistics, analyzing multiple paths and 
multiple hops, and SA Agent monitoring. The Concord application does not 
provide these features.

I currently own IPM Release 1.0 for Solaris. Can I 
upgrade to IPM Release 2.3?

No. You must upgrade from IPM Release 1.0 to IPM Release 2.0 before you can 
install IPM Release 2.3.

I currently own IPM Release 1.0 for AIX or HP-UX. 
Can I upgrade to IPM Release 2.3?

No. IPM 2.3 currently supports server functionality on Solaris, Windows NT and 
Windows 2000 Professional and Server only. Client functionality is supported on 
Solaris, Windows 98, Windows NT, and Windows 2000 Professional and Server.
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I upgraded my IPM servers to Release 2.3, and now IPM is not working. Why?
The AIX and HP-UX releases of IPM have been End of Lifed (EOLed). There are 
no plans at this time to support future releases of IPM on AIX or HP-UX.

I upgraded my IPM servers to Release 2.3, and now 
IPM is not working. Why?

When you upgrade IPM servers and clients, you must upgrade your IPM servers 
and clients to the same version and release level, such as Release 2.3.

How much of the router’s memory do collectors in 
SA Agent consume?

The router memory consumed by Echo collectors depends on the release of Cisco 
IOS software running on the router:

• For routers running Cisco IOS software Release 11.2 to 11.3 or 12.0, each 
Echo collector consumes 40 KB of router memory.

• For routers running Cisco IOS software Release 12.0(5)T or later, each Echo 
Collector consumes 18 KB of router memory.

The router memory consumed by a Path Echo collector is dependent on the 
number of paths and the number of hops in the path for each collector. Path Echo 
operations might consume significant amounts of memory on the source router.

How frequently can network performance 
measurements be taken?

SA Agent generates several measurements per hour, then IPM polls the router 
once per hour and collects summarized statistics for that period. You can set the 
sampling interval for SA Agent for as often as every 10 seconds, but for optimal 
performance, we recommend a sample interval of at least 60 seconds (1 minute). 
This is the default value.
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When I make changes to IPM components, how can I force IPM to detect the changes now, without waiting for the 
You can view up-to-date real-time statistics in the Real Time Statistics window as 
SA Agent collects the data from the collector. However, IPM does not store the 
real-time data in the IPM database. IPM stores only the hourly summarized data 
in the IPM database.

When I make changes to IPM components, how can 
I force IPM to detect the changes now, without 
waiting for the next automatic poll?

IPM typically polls source routers once every hour. Therefore, IPM detects 
component changes in from 1 to 59 minutes, depending on when the last poll 
occurred. (It can take up to two hours for IPM to detect the reboot of a source 
router and reconfigure any associated collectors.)

However, you can use one of the following procedures to force IPM to detect your 
changes immediately:

• From the IPM Main window, select View > Properties, then click the 
timestamp under the Last Update Time field. Doing so updates the source 
router’s properties in the IPM database.

• From the IPM Main window, select Edit > Configuration. Doing so updates 
the source router’s properties in the IPM database.

• Issue the ipm restart command to force IPM to synchronize with all source 
routers. This command restarts all IPM servers and managed processes on the 
local host.

Note Use the ipm restart command only if you reconfigured your 
network and rebooted your routers, and IPM did not detect the 
reconfiguration and rebooted, but otherwise is working normally.
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When IPM collects the data from the SA Agent using SNMP, is this data averaged or summarized in any way?
When IPM collects the data from the SA Agent using 
SNMP, is this data averaged or summarized in any 
way?

The data is summarized and averaged in a variety of ways. IPM displays the data 
in the Historical Statistics window in hourly, daily, weekly, and monthly 
increments. IPM also displays average, minimum, and maximum calculations of 
the data over the monitoring period. IPM also provides an automatic aging facility 
for summarizing and aging older data.

Are there plans to support IPM on Solaris for Intel 
platforms?

No. The demand for IPM running on this platform is fairly low, while the demand 
for supporting other platforms and adding additional features to the existing 
platforms is fairly high. Therefore, supporting IPM on Solaris for Intel is unlikely.
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What data collectors are available in IPM 2.3?
What data collectors are available in IPM 2.3?
IPM Release 2.3 provides support for the following types of operations:

• DHCP Echo

• DLSw Echo

• DNS Echo

• Enhanced UDP with Jitter Monitoring

• HTTP Connect

• ICMP Echo

• ICMP Path Echo

• SNA Echo

• TCP Connect

• UDP Echo

This release also provides support for Loose Source Routing and Quality of 
Service.

For TCP Connect operations, what port numbers does 
IPM support?

You can make a TCP connection to any port number, well known or otherwise, on 
any IP host, Cisco or non-Cisco, as long as someone is listening on that port on 
the target.

If you specify a target for a target uses the SA Agent, make sure you configured 
it as a Cisco SAA Responder target on the Target Configuration window. If you 
mistakenly configured it as an IP target, and you specify a Target Port that is not 
well known (that is, if you specify a port number greater than 1024), IPM 
considers the target an IP device rather than an SA Agent device and does not 
enable the SA Agent Control protocol. As a result, the collector cannot connect to 
the target and no data is collected.
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Why does my TCP Connect collector generate “No Connection” errors when I use an SA Agent device as the target,
Why does my TCP Connect collector generate “No 
Connection” errors when I use an SA Agent device 
as the target, with a target port number greater than 
1024?

Make sure you configured the target as a Cisco SAA Responder target on the 
Target Configuration window. If you mistakenly configured it as an IP target, and 
you specify a Target Port that is not well known (that is, if you specify a port 
number greater than 1024), IPM considers the target an IP device rather than an 
SA Agent device and does not enable the SA Agent Control protocol. As a result, 
the collector cannot connect to the target and no data is collected.

Why won’t IPM accept my timeout values for TCP 
Connect and DNS operations?

To ensure interoperability with Cisco IOS, the Timeout Values for TCP Connect 
and DNS operations are fixed at 60000 and 9000 milliseconds, respectively. If you 
enter some other value, IPM changes the value you enter to the default value.

For UDP operations, what port numbers does IPM 
support?

For UDP connections, valid port numbers are 7, and 1025 to 65535.

• If the target device is a Cisco router running version 12.1 or later of the Cisco 
IOS software, you can specify any port that is not well known (that is, you 
can specify any port number greater than 1024) to communicate with the 
SA Agent Responder, as long as someone is listening on that port on the 
target. The only allowed well known port is UDP port 7.

• If the target is not running version 12.1 or later of the Cisco IOS software, 
whether a Cisco or a non-Cisco IP host, you must specify UDP port 7 as the 
target port.
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Does IPM provide a default HTTP operation?
Does IPM provide a default HTTP operation?
No. You must create your own HTTP operations. See the “Measuring Network 
Performance for HTTP” section on page 3-15 for information about creating a 
new HTTP operation.

Note The DefaultHTTPConn operation is not a true HTTP operation, it is a 
TCP Connect operation. (DefaultHTTPConn was called DefaultHTTP 
prior to IPM Release 2.2.)

Is IPM packaged with CiscoWorks2000?
Yes. Beginning with IPM Release 2.1, IPM is packaged with CiscoWorks2000 in 
the Routed WAN Management bundle. In future, IPM might be included in other 
CiscoWorks2000 bundles.

How many data collectors can IPM support?
There is no functional limit on the number of collectors that IPM can support. 
However, we recommend you limit the maximum number of collectors per IPM 
server to 1000. To support more than 1000 collectors, you can deploy multiple 
IPM servers. Many users deploy an IPM server in each geographic area of their 
network.

When IPM configures the routers, it seems that the 
configuration is a running configuration and not 
saved. What happens when the router is rebooted?

IPM handles configuring the source router using running configurations entirely. 
IPM automatically reconfigures the router after a reboot. You do not have to do 
anything special from the router command line after a reboot. Also, IPM does not 
interact with or destroy any manually generated collectors.
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Where can I find the latest information and software updates for IPM?
Where can I find the latest information and software 
updates for IPM?

Updated product information and software updates for IPM are available at the 
following URL:

http://www.cisco.com/kobayashi/sw-center/netmgmt/cw2000/IPM.html

Is the IPM database schema published?
Yes. The IPM database schema is available on the IPM product CD, in the docs 
directory.

What if I lose a connection to a server?
If your client loses its connection to the configuration server, real time poller, data 
view server, or data collector, IPM attempts to recover the connection 
automatically, as follows:

Step 1 IPM displays the following message:

Connection to server Lost. Will try to reconnect.

where server is the name of the server to which the connection was lost.

Step 2 IPM attempts to reconnect to the server.

Step 3 If the attempt succeeds, IPM displays the following message:

Reconnection Successful.

Step 4 IPM closes all windows except the IPM Main window.

Step 5 IPM queries the server for the collector list to make sure no messages were 
missed.

Step 6 You can continue using IPM as usual.
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Why does IPM lock up sometimes when I’m running in a Web browser?
If the attempt to reconnect to the server fails, IPM displays the following message:

Reconnection to the server Failed. Please shutdown this client or restart 
the server.

To recover, you must either shutdown the client or restart the server.

Why does IPM lock up sometimes when I’m running 
in a Web browser?

IPM might not be locked up. Instead, a message might have popped up in the 
background, preventing you from interacting with other windows. If you are 
running IPM in a Web browser, and you suspect your display has locked up, look 
for an IPM message popup in the background before taking any other action.

This problem also can occur when you launch the Seed File window or the 
Statistics Data Filter window.

I launched the IPM client from the command line, 
and now I can’t launch the client from a Web 
browser session. Why?

This problem occurs only when all the following conditions are met, in order:

Step 1 A Web browser session is not open on your workstation.

Step 2 You use the ipm or ipm start client command to start the IPM client from the 
command line.

Step 3 You take some action that opens a Web browser session (such as opening Help for 
the IPM client).

If all the above conditions are met, you might not be able to launch the Web client 
from the Web browser.
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Why can’t I access IPM Help on my Solaris workstation?
To avoid this problem, make sure you have a Web browser session open whenever 
you start the IPM client from the command line.

Why can’t I access IPM Help on my Solaris 
workstation?

First, make sure you have an Internet Explorer or Netscape Navigator Web 
browser installed. If you do, enter the following UNIX command on your local 
workstation:

xhost +remote_machine

This command allows the remote workstation called remote_machine to access 
your local workstation.

Do keyboard shortcuts work when I run IPM in 
Netscape Navigator?

No. If you are running IPM in Netscape Navigator, keyboard shortcuts (such as 
Ctrl-F for Edit > Configuration) do not work. You must use the menu bar to 
access these functions.

Keyboard shortcuts work when you run IPM in Internet Explorer.
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In the Target Configuration window, all of my targets show Responder On as either No (off) or Not Applicable. How 
In the Target Configuration window, all of my targets 
show Responder On as either No (off) or Not 
Applicable. How can I turn on the Responder for a 
target?

When you configure a router, the SA Agent Responder is disabled by default. To 
turn on the Responder for a target, you must enable the Responder at the router 
using the rtr responder configuration command. Also, you must run SA Agent 
software version 2.1.1 or later to see the results.

Why won’t IPM let me delete one of my targets?
If you try to delete a target and IPM issues an error message such as Could not 
delete the target, the reason might be one of the following:

• The target is being used as a final target by one or more collectors.

• The target is being used as an intermediate hop by one or more Path Echo 
collectors.

See the “Deleting Targets” section on page 4-11 for details about how to resolve 
this problem.

If I see errors in graphs, what are some problems to 
look for?

If you see “No Connection” or other errors when you display Real Time or 
Historical graphs, here are some common problems to look for and correct:

• Did you create any collectors on inactive PUs?, page A-25

• Did you create any collectors when no LUs were available?, page A-25

• Did you create any HTTP collectors that require authentication?, page A-25

• Did you specify any incorrect target PU names?, page A-26
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If I see errors in graphs, what are some problems to look for?
• Did you specify any incorrect IP addresses?, page A-26

• Did you specify large mainframe RU sizes?, page A-26

Did you create any collectors on inactive PUs?
Collectors that you create on inactive physical units (PUs) accrue no data for Real 
Time or Historical graphs. The Real Time graph displays “No Connection” for the 
Last Data Point.

To avoid this problem, make sure the PUs are active before you create collectors 
on them. To display the status of the PU from the router, use the show sna IOS 
command or the show dspu IOS command (for downstream PUs).

Did you create any collectors when no LUs were available?
Each collector creates a logical unit (LU) connection to the mainframe. Therefore, 
if you create collectors when all LUs were used, those collectors accrue no data 
for Real Time or Historical graphs. For example, if 20 LUs were activated by the 
host (mainframe) and 20 LUs were used for 20 collectors, the 21st created 
collector would accrue no statistics. The Real Time graph displays “No 
Connection” for the Last Data Point.

To avoid this problem, make sure the number of collectors you create is equal to 
or less than the number of LUs defined on the mainframe. To display the number 
of LUs defined on the mainframe that are still available, use the show sna IOS 
command.

Did you create any HTTP collectors that require authentication?
If you create an HTTP collector using a URL Lookup String that requires 
authentication (that is, a user name and password), no statistics are collected. The 
HTTP General Error or HTTP Timeout Error window appears.

Similarly, if you create an HTTP collector and specify a URL Lookup String that 
is separated from the source router by a firewall, no statistics are collected. The 
Real Time graph displays the “TCP Timeout” error message. You might see a 
DNS error message as well, if there is no entry in the DNS table for the URL 
Lookup String.
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If I see errors in graphs, what are some problems to look for?
Did you specify any incorrect target PU names?
When you run an SNA collector, use the PU you defined for the source router as 
the target PU name. When you use service point PUs, use the service point PU 
name configured in the router as the target PU name.

In the following example, the source router is cwb-ipm-2500a, and the target PU 
name must be IPM2500A:

sna host IPM2500A xid-snd 05ddd025 rmac 4001.7200.d022 rsap 4 lsap 4 
focalpoint
cwb-ipm-2500a#

Did you specify any incorrect IP addresses?
If you receive a "No Connection" error from the Real Time graph when you create 
DLSW collectors, make sure the DLSW source IP address and target IP address 
are both correct. Use the View > Properties menu option to display these 
addresses. If either address is missing or incorrect, add the correct address and 
recreate the collector with the correct addresses.

Did you specify large mainframe RU sizes?
When you modify Request Payload and Response Payload sizes (for 
RU-response/request units), do not exceed the defined mainframe RU sizes. 
Doing so causes Real Time graph errors, such as the “Data Verification Error.” If 
you must modify the Request Payload and Response Payload parameters to make 
them smaller, you can access them from the Edit > Configuration > Operations > 
Echo > Packet Settings for SNA LU0 and SNA LU2 menu.
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On the Source Properties window, how is it possible for my system up time to be longer than the time since the last
On the Source Properties window, how is it possible 
for my system up time to be longer than the time 
since the last reboot?

If a source router cannot be reached, or is in the process of rebooting, the Source 
Properties window might display an incorrect, backlevel system up time for that 
router. If the system up time is longer than the time since the last reboot, wait a 
few seconds, then refresh the screen to display the correct system up time.

When I enter the show rtr configuration command, I 
see RTR-related configuration settings on my source 
routers. Why?

This is normal, expected behavior, and nothing to be concerned about.

IPM uses SNMP for all configuration tasks. SNMP in turn generates RTR 
configuration statements. Those RTR configuration statements typically appear 
only in the running configuration; they are not saved to the nonvolatile RAM 
(NVRAM) configuration.

The RTR configuration statements affect only RTR-based functions. They have no 
other effect on router configuration.

Does IPM support data export?
Yes. IPM supports export to comma-separated value files, as well as to HTML 
files.
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How do I change the IP address or host name of an IPM server?
How do I change the IP address or host name of an 
IPM server?

If you must change the IP address or host name of the server on which IPM is 
running, keep the following considerations in mind:

• If you change the IP address of the IPM server, but the host name of the server 
remains unchanged, IPM is not impacted. If the /etc/hosts, host name, DNS, 
Network Information Services (NIS), netmask, and so on are all configured 
correctly with the new IP address, the IPM server and client work correctly 
after you reboot the system.

• (Solaris only) If you change the host name of an IPM system, IPM no longer 
starts up or works correctly. To correct this problem, issue the ipm hostname 
command, then reboot the system.

Why do I get an error message when I use a host 
name as a new IP address?

If you get a “Host not found” error when you use a host name as the new IP 
address, you must enter the actual IP address as the new IP address.

In general, you should not use a host name in the New IP Address field of the 
Change IP Address window. It only works if there is a single DNS entry for the 
device, and if the domain name exactly matches the one in the database.
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My client system has multiple IP addresses and I'm having problems staying connected to the IPM server from this
My client system has multiple IP addresses and I'm 
having problems staying connected to the IPM 
server from this client. How can I correct this 
problem?

This problem occurs because the IPM server does not know which address to use 
when responding to the client. The client talks to the server using one address, but 
the server responds using another one listed in the naming server for the client.

To correct this problem, issue the ipm clientaddr command. This command 
forces the IPM client to bind to a specific IP address, an address to be used by both 
the client and the server.

When you select an address, specify the primary address used by the client, and 
make sure the server can access the address.

What if I accidentally create a collector that uses all 
remaining memory in the source router?

The SA Agent in IOS 12.1 and later provides a low-watermark feature to prevent 
collectors from using all the memory in the source router. Refer to the 
Cisco IOS Configuration Fundamentals Command Reference for details on the 
rtr low-memory command.

What is casusers group?
To address a CiscoWorks2000 security issue, IPM 2.3 will no longer be installed 
under the user, bin. IPM 2.3 will be installed under the new user, casuser, which 
belongs to the new group, casusers.
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In IPM 2.3, why do file permissions get changed to casuser::casusers after installation?
In IPM 2.3, why do file permissions get changed to 
casuser::casusers after installation?

To address a CiscoWorks2000 security issue, IPM 2.3 will no longer be installed 
under the user, bin. IPM 2.3 will be installed under the new user, casuser, which 
belongs to the new group, casusers.

In Solaris, the casuser account has the following attributes:

• Does not have password 

• Does not have UNIX shell 

• Has write permission to the directory /var/adm/CSCOpx 

• Does not have root privileges 

In Windows NT and Windows 2000, the casuser account has the following 
attributes:

• An initial password entered by the system administrator during installation 

• No administrative privileges 

This ensures that there is no unauthorized access. 

In IPM 2.3, why can some commands be run by root 
only, and others by members of the casusers group?

This is to address a security issue. Members of the casusers group will not have 
permissions to run all commands. IPM allows only the user with administrative 
privileges to run all commands. For any user to run any IPM command they must 
be a member of the group, casusers.
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After remote upgrade, why do collectors encounter synchronization problems if both versions of IPM are run
After remote upgrade, why do collectors encounter 
synchronization problems if both versions of IPM are 
run simultaneously?

After remote upgrade collectors might encounter synchronization problems if 
both versions are run simultaneously. This occurs when both versions of IPM are 
trying to manage the same set of routers. To solve this problem you should 
terminate the earlier version of IPM.

Can IPM 2.3 co-exist with older versions of IPM on 
the same network?

IPM 2.3 co-exists well with IPM 2.2. However, when you have IPM 2.0 with IPM 
2.3 on the same network, you might encounter problems with the MsgLogServer. 
It is recommended that you do not run IPM 2.0 along with IPM 2.3 in the same 
network.

Do not run the same set of collectors while simultaneously running two different 
versions of IPM.
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Can IPM 2.3 co-exist with older versions of IPM on the same network?
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